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Setup menu

Window menu

Help menu
EmbroideryStudio provides various ways to access 
information about the software and how to use it via 
the Help menu. See Resources & support for details.

EmbroideryStudio toolbars

The ES Decorating window contains the toolbars 
described below. Some tools are shortcuts to pulldown 
menu commands. Details of optional toolbars are 
provided in the onscreen documentation.

Note  Only the most commonly used toolbars are on 
by default.

Standard toolbar
The Standard toolbar contains commonly used tools 
and commands which are specific to and only visible in 
Wilcom Decoration.

Prepare Bitmap 
Colors

Prepare bitmap images for automatic digitizing.

Edit Using > Edit bitmaps using Paint, Corel PHOTO-PAINT, 
or Paint Shop Pro.

Turning Satin 
Object

Fill narrow column shapes with turning stitching.

Tatami Fill 
Object with 
Holes

Fill large shapes with Tatami stitching, 
preserving any holes

Tatami Fill 
Object

Fill large shapes with Tatami stitching, ignoring 
any holes.

Centerline Run 
Object

Create centerlines in narrow shapes with Run 
stitching.

Outline Run 
Object

Create outlines around shapes with Run 
stitching.

Auto Trace to 
Vectors

Convert artwork to vector objects. These can be 
converted to embroidery objects.

Adjust Bitmap Adjust image lightness and contrast.

Photo Flash Create whole embroidery designs directly from 
photographs.

Color 
PhotoStitch

Automatically turn photographs and other 
bitmap artwork into multi-colored embroidery.

Add Bitmap 
Colors

Assign matching thread colors from selected 
chart/s to the current colorway.

General 
Options

Access current settings for design window 
object display.

Manage Thread 
Charts

Define your own thread charts. When you create 
a thread chart, you are creating a store of colors 
for future use.

Manage Auto 
Fabrics

Modify existing fabric definitions and create new 
ones. 

Manage Styles Define new styles for a template, either from 
scratch or based on an existing style or object.

My Hoops Configure My Hoop list to include only hoops 
available for use.

Manage Motifs Manage your custom motif sets.

Manage 
User-Refined 
Letters

Adjust height range and other settings for 
custom ‘user-refined’ letters.

Manage 
Alphabets

Modify custom alphabets by changing names, 
default letter spacings and join types.

Convert 
TrueType Font

Convert a TrueType font to an embroidery font.

Calibrate 
Screen

Set up your monitor. 

Connection 
Manager Setup

Connect to machines that appear as removable 
media or make use of third-party connection 
software.

Tablet Setup Set up digitizing tablet.

Scanner Setup Set up Scanner.

Bling Machine 
Setup

Set up direct connection to CAMS automatic 
rhinestone placement machine.

Machine 
Runtime Setup

Set up multiple named machines for the 
purposes of runtime analysis.

Security Device 
Setup

Show/set security device.

New ... Tab 
Group

Split the design window into a second tab group, 
either vertical or horiztonal. Each tab group can 
contain multiple designs.

Move to ... Tab 
Group

Move a current design to the other design tab. 
Can also be dragged to the other design group.

Remove Tiling Remove tab groups and split windows and 
return to a single design window.

Split Window Split design tab into multiple views of the same 
design.

Dockers > Show/hide dockers to optimize working area.

Toolbars > Show/hide toolbars to optimize working area.

Kiosk Lettering kiosk capability for cap and other 
embroidery for use at retail outlets where simple 
personalization of standard design layouts is 
required.

More Windows View more open windows.

New Create a new design file.

Open Design Open an existing embroidery design.

Open 
Recent 
Designs

Open a design from a list of recently opened 
designs.

Save Design Save the current design file.

Print Print the current design file.

Print 
Preview

Preview design worksheet/approval sheet. 
Print from preview window.

Cut Cut selection and place on Clipboard.

Copy Copy selection and place on Clipboard.

Paste Paste contents of Clipboard. Options 
available in Options > Edit tab.



   Quick Reference 882

Mode toolbar
This toolbar contains tools pertaining to interactions 
between Wilcom Decoration and CorelDRAW 
Graphics.

Docker toolbar
Docker tools allow you to toggle modeless dialogs 
(dockers) on or off. See also Working with dockers.

Color Palette
The Color Palette contains a palette specific to and 
only visible in Wilcom Decoration. See Choosing 
thread colors for details.

Undo Undo previous action.

Redo Redo previously undone action.

Import 
Embroidery

Import embroidery design file into current 
design. 

Import 
Graphic

Import artwork into current design as a 
backdrop for manual or automatic digitizing.

Export Multi- 
Decoration 
Files

Export mixed decoration design components 
as file formats for use by control software or 
machine. 

Send to 
Connection 
Manager

Send current design to machine via 
proprietary machine software.

Send to 
Appliqué 
Cutter

Send appliqué shapes from design file to 
laser cutter. 

Send to 
Bling Cutter

Send vectors for any bling in a 
multi-decoration design to a supported cutting 
machine. Configure the machine via Setup. 

Zoom Scale: Select zoom scale from droplist

Options Access application options for design view, 
grid & guides, and other settings.

Switch to 
CorelDRAW 
Graphics

Access full graphic creation and editing 
toolset.

Switch to Wilcom 
Decoration

Access full embroidery creation and 
editing toolset.

Design Library

Open the Design Library window from 
which to search and catalogue designs 
as well as quotes, orders, and 
approvals.

Convert 
Embroidery to 
Graphics

Convert selected embroidery to vector 
graphics and switch to CorelDRAW 
GraphicsCorelDRAW Graphics.

Convert Graphics 
to Embroidery

Convert selected graphics to 
embroidery and switch to Wilcom 
Decoration.

Tag as Appliqué Tag vector lettering for conversion to 
appliqué embroidery lettering with 
turning stitching.

Tag Fill as Turning 
Satin

Use this tag only for narrow vector 
objects, such as lettering-like vectors.

Tag as Photo Flash Convert photos to Photo Flash 
embroidery. 

Keep Original 
Objects Keep original objects after conversion.

Match to 
Embroidery Palette

Toggle thread-color matching for 
converted vector objects. 

Show Embroidery Toggle embroidery object display.

Virtual Decoration Quality: set the 
rendering quality of embroidery 
TrueView for a virtual decoration.

Design 
Properties

Access design properties including job order 
details.

Overview 
Window

Toggle Overview Window display. Use to 
view and pan thumbnail of current design. 

Object 
Properties

Toggle Object Properties display. Use it to 
preset properties or adjust for selected 
objects.

Color-Object 
List

Toggle Color-Object List display. Use to view 
and sequence design objects.

Colorway 
Editor

Toggle Colorway Editor display. Use it to 
assign thread colors to color palette and 
define colorways.

My Threads
Show or hide the My Threads docker to find 
threads from different charts and change 
design colors.

Stitch List Toggle Stitch List display. Use it to view, filter 
and select stitches.

Team Names Toggle Teamname List display. Use it to view 
and edit individual team names. 

Carving 
Stamp

Toggle Carving Stamp display. Use to create 
needle penetrations using a ‘carving stamp’ 
as template.

Current Colorway: switch between 
pre-defined colorways. Define via Colorway 
Editor.

Colorway 
Editor

Toggle Colorway Editor display. Use it to 
assign thread colors to color palette and 
define colorways.

Background & 
Display Colors

Change design background and display 
color presets for the current colorway. 

Product 
Visualizer

Toggle Product Visualizer docker display. 
Use it to edit the current product in the 
design window.

Current Color Shows the current color.

Pick Color Pick up a color from the design window and 
make it current.

Apply Current 
Color

Apply the current color to embroidery 
objects. 

Add Color Add color slot to palette. Edit via the 
Colorway Editor.

Remove Color Remove unused last color slot from color 
palette.

Hide Unused 
Colors

Show or hide all unused colors in the color 
palette.

Remove 
Unused Colors Remove unused colors from the palette.

Split Palette 
Color

Split selected color into two color slots. 
Normally used with multiple colorways.
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Property bar
Adjust general object properties – width, height, 
position – by means of the Property Bar. Changes to 
the values are applied by pressing Enter on the 
keyboard. They are discarded when you press Esc or 
click anywhere outside the fields. See Accessing object 
properties for details.

Status & Prompt bars
The Status and Prompt bars provide continuous 
display of current cursor positDesign PropertiesDesign 
Propertiesion status as well as instructions for use of 
selected tools. See Operating modes for details.

Toolbox toolbar
The Toolbox contains the embroidery 
digitizing/editing tools specific to and visible only in 
Wilcom Decoration. Related tools are grouped into 
‘flyouts’. By default, the Toolbox docks vertically to 
the left of screen but can be floated, re-configured, 
and docked like any other toolbar.

Select tools
The Select tools let you to select all embroidery 
objects in a design, cancel all selections, or remove 
individual objects from a selected group. See Selecting 
objects for details.

Reshape tools 
The Reshape tools let you reshape objects with 
control points as well as edit individual stitches. See 
Reshaping embroidery objects for details. See also 
Stitches & Machine Functions.

Cycle Used 
Colors

Cycle through combinations of used colors. 
Left- or right-click. 

Color Wheel Access Color Wheel to test combinations of 
related colors. 

My Threads
Show or hide the My Threads docker to find 
threads from different charts and change 
design colors. 

Select See Select tools for details.

Reshape See Reshape tools for details.

Edit See Edit tools for details.

Lettering
Create embroidery lettering onscreen using 
native embroidery fonts or TrueType fonts. 
Right-click for settings.

Team 
Names

Toggle Teamname List display. Use it to view 
and edit individual team names. 

Monogram- 
ming

Create monograms using a selection of 
pre-defined monogramming styles, border 
shapes and ornaments.

Simple 
Offsets

Create simple outlines for any filled 
embroidery or closed vector object.

Outlines & 
Offsets

Create accurate outlines and offsets for any 
closed embroidery or vector object.

Add Border Add borders to designs (or selected objects) 
from a border library.

Color 
Blending

Generate color blends, perspective effects 
and shading in selected objects.

Auto-
Digitizing See Auto-Digitizing tools for details.

Envelope See Envelope tools for details.

Arrange See Arrange tools for details.

Mirror Merge See Mirror Merge toolbar for details.

Shaping See Shaping toolbar for details.

Select 
Object

Click to select individual objects. Use with Ctrl 
or Shift keys to select groups or ranges of 
objects. Drag a selection marquee to select 
multiple objects. 

Freehand 
Select

Select object by drawing a freehand line 
around it.

Select 
Current Select object at current cursor position.

Polygon 
Select

Select objects by digitizing a selection 
marquee around them.

Polyline 
Select

Select objects by digitizing a line through 
them.

Reshape 
Object

Reshape selected objects, edit stitch angles, 
and adjust entry/exit points. Right-click for 
settings.

Show 
Reshape 
Nodes

Toggle reshape nodes for selected objects.

Show Bézier 
Handles

Toggle Bézier handles for selected objects. 
(Only available when the Bézier reshape 
option is selected in the Options > Reshape 
tab.)

Show Stitch 
Angles Toggle stitch angles for selected objects.

Show 
Entry/Exit

Toggle entry (green diamond) and exit (red 
cross) points for selected objects.

Stitch Edit Select individual stitches for editing.

Keep Last 
Stitch Keep last stitch in a column. 

Omit Last 
Stitch Omit last stitch in a column. 
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Edit tools
The Edit tools contains tools for object editing 
operations. See Reshaping Objects for details.

Auto-Digitizing tools
The Auto-Digitizing tools provide everything 
necessary to automatically digitize shapes in electronic 
artwork, both bitmap and vector, without using manual 
input methods. See Auto-digitizing image shapes in 
the User Manual.

Envelope tools
Envelopes are typically applied to lettering objects, but 
they can also be applied to other types of embroidery 
object. See Applying envelopes for details.

Arrange tools
The Arrange toolbar contains tools for moving, 
aligning and distributing objects, including grouping 
and locking tools. See Modifying Objects for details.

Break Apart
Split branched objects – monograms, 
appliqués, lettering, etc – into components. 
Allows each to be edited individually.

Knife Cut objects along a digitized line, preserving 
stitch settings and colors.

Automatic 
Knife

Slice large objects into smaller ones with 
automatic overlaps.

Instant Smart 
Design

Automatically create embroidery from 
imported artwork instantly.

Smart Design Create whole embroidery designs directly 
from imported artwork.

Keep Original 
Objects

Retain the original artwork during 
conversion.

Color 
Matching 
Method

Toggle thread color matching for auto 
digitizing.

Crop Bitmap
Crop bitmap artwork for use with 
auto-digitizing tools.

Remove Crop
Click to remove crop. 

Prepare 
Bitmap Colors

Prepare bitmap images for automatic 
digitizing.

Turning Satin 
Object

Fill narrow column shapes with turning 
stitching.

Tatami Fill 
Object with 
Holes

Fill large areas with Tatami stitching, 
preserving any holes.

Tatami Fill 
Object

Fill large areas with Tatami stitching, ignoring 
any holes.

Centerline 
Run Object

Create centerlines in narrow shapes with 
Run stitching.

Outline Run 
Object

Create outlines around shapes with Run 
stitching.

Auto Trace To 
Vectors

Convert artwork to vector objects. These can 
be converted to embroidery objects.

Adjust Bitmap Adjust image lightness and contrast in 
preparation for auto-digitizing.

Photo Flash Create whole embroidery designs directly 
from photographs.

Color 
PhotoStitch

Automatically turn grayscale or color 
photograph into embroidery. 

Bridge 
Envelope

Make lettering object to make it bulge or 
arch.

Penant 
Envelope  Make objects compress.

Perspective 
Envelope Make objects bulge or stretch.

Diamond 
Envelope Make objects bulge or compress.

Delete 
Envelope Delete envelopes from selected objects.

Group Group selected objects.

Ungroup Ungroup selected grouped objects.

Lock Lock selected objects.

Unlock All Unlock all locked objects in design.

Branching Automatically sequence and group like 
embroidery objects. 

Apply 
Closest Join

Join selected objects at the closest point. 
Re-apply closest join after editing. 

Break Apart
Split branched objects – monograms, 
appliqués, lettering, etc – into components. 
Allows each to be edited individually.

Align Left Left-align selected objects.

Align 
Centers 
Vertically

Align centers of selected objects vertically.

Align Right Right-align selected objects.

Align Top Align tops of selected objects.

Align 
Centers 
Horizontally

Align centers of selected objects horizontally.

Align 
Centers Align selected objects through their centers. 

Align Bottom Align bottoms of selected objects.

Space 
Evenly 
Across

Distribute selected objects evenly across 
design window.

Space 
Evenly Down

Distribute selected objects evenly down 
design window.
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Mirror Merge toolbar
Mirror Merge tools allow you to duplicate and 
transform selected embroidery objects, as well as 
merge them into a single object. See Mirroring objects 
for details.

Shaping toolbar
When working with overlapping vector or embroidery 
objects, you can merge, trim or split them using the 
Shaping tools. See Shaping objects for details.

Graphics Digitizing tools
The Graphics Digitizing toolbar contains digitizing 
tools that operate in a similar way to CorelDRAW® 
Graphics Suite or other graphics applications. Assign 
a stitch type to a shape by selecting from the Outline 
Stitch Types or Fill Stitch Types toolbar. See also 
Digitizing with graphical tools. See also Appliqué 
Digitizing.

Stitch Angle tools
Stitch angle adjustments depend on object type. With 
Complex Fill objects you can set a single stitch angle 
for the entire object. You can add multiple stitch angles 

Make Same 
Width

Scale selected object/s to same width as 
last-selected reference object.

Make Same 
Height

Scale selected object/s to same height as 
last-selected reference object.

Make Same 
Width & 
Height

Scale selected object/s to same size as 
last-selected reference object.

Mirror Copy 
Horizontal

Duplicate and mirror horizontally and merge 
overlapping objects (optional). 

Mirror Copy 
Vertical

Duplicate and mirror vertically and merge 
overlapping objects (optional). 

Mirror Copy 
Horizontal & 
Vertical

Duplicate and mirror selected objects around 
a center point.

Array
Duplicate designs, such as badges, 
automatically re-sequencing color blocks for 
efficient multiple design stitchouts.

Reflect Duplicate and mirror objects or designs. Use 
to create decorative borders.

Wreath Duplicate objects around a center point. Use 
to create wreath designs.

Kaleidoscope Mirror paired objects in a wreath.

Mirror Merge Settings

Rows: Set number of rows in the array.

Row Spacing: Set spacing between rows in 
the array.

Columns: Set number of columns in the 
array.

Column Spacing: Set spacing between 
column in the array.

Wreath Points: Set number of duplicates 
(including source). Kaleidoscope works best 
with an even number.

Set precise Distance and Angle – measured 
from center of source object to center of 
wreath or kaleidoscope.

Weld Merge selected overlapping objects into a 
single ‘flattened’ object.

Intersect Trim selected overlapping objects so that only 
intersected areas remain.

Exclude Trim selected overlapping objects and 
preserve individual properties.

Front-Back
Trim selected overlapping objects so that only 
non-overlapping areas of the topmost object 
remain.

Back-Front
Trim selected overlapping objects so that only 
non-overlapping areas of the bottommost 
object remain.

Flatten Trim all overlaps in selected overlapping 
objects.

Divide Split selected objects into separate adjoining 
objects wherever they intersect.

Combine Merge properties of selected overlapping 
objects and trim overlapping areas.

Keep 
Original 
Objects

Keep original objects after shaping 
operations.

Overlap: Adjust object overlaps resulting from 
Flatten or Divide shaping operations.

Digitize 
Open Shape

Digitize open object in the current stitch type 
– outline only.

Digitize 
Closed 
Shape

Digitize closed object in the current stitch type 
– outline or fill.

Digitize 
Column

Digitize column of varying width in the current 
stitch type – outline or fill.

Rectangle
Digitize rectangle or square in the current 
stitch type – outline or fill. Press <Ctrl> to 
constrain.

Ellipse Digitize ellipse or circle in the current stitch 
type – outline or fill.

Basic 
Shapes

Digitize basic shapes. Press <Ctrl>to keep 
the proportion of the shape. Press <Shift> to 
center at the first point entered.

Freehand 
Open Shape

Draw open freehand object in the current 
stitch type – outline only.

Freehand 
Closed 
Shape

Draw closed freehand object in the current 
stitch type – outline or fill.

Stitch Angles See Stitch Angle tools for details.

Add Holes See Hole tools for details.

Auto 
Appliqué See Appliqué tools for details.

Maciej
Highlight

Maciej
Highlight

Maciej
Highlight
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with the Stitch Angles tool. See Adjusting stitch 
angles for details.

Hole tools
EmbroideryStudio provides special tools for cutting 
holes in objects as well as filling holes in objects. See 
Adding & filling holes for details.

Appliqué tools
The Appliqué toolbar contains tools specific to 
appliqué work. These include tools for creating 
appliqué objects, resequencing them for efficient 
stitchout, as well as generating partial cover stitching 
for overlapping appliqué objects. See Appliqué 
Digitizing for details.

Traditional Digitizing tools
The Traditional Digitizing tools provide all the input 
methods embroidery digitizers are familiar with. 
Traditional digitizing methods divide into three main 
categories – ‘free shapes’, ‘column shapes’, and 
‘outlines’. See also Embroidery digitizing.

Manual tools
The Manual Tools provides tools for digitizing 
individual stitches with the Manual method. Enter 
single manual stitches or three stitch layers at a time. 
See Digitizing manual stitches for details.

Stitch Types toolbar
The Stitch Types toolbar provides a range of basic 
outline and fill stitch types as well as those of a more 
artistic or decorative kind. Left-click icons to select 
stitch type. Right-click to access stitch settings. See 
also Stitch Types.

Stitch Angles Add stitch angles to selected objects. 

Remove 
Stitch Angles

Remove stitch angles from closed objects 
with turning stitches.

Add Holes Add hole/s to selected filled object.

Fill Holes Fill hole/s in selected object. Choose an exact 
fit or offset the edges.

Remove 
Holes Remove hole/s from selected object.

Auto 
Appliqué

Digitize appliqué object with up to four layers 
of stitching - guide run, cutting line, tack 
stitches, and cover stitches. 

Combine 
Appliqué

Combine and sequence components of 
selected appliqué objects for efficient 
stitchout.

Partial 
Appliqué

Create partial cover stitching for overlapping 
appliqué objects.

Remove 
Overlaps

Remove underlying layer of stitching in 
overlapping objects.

Digitize Run Create row of single stitches along a digitized 
line.

Backtrack Reinforce an outline, stitching it in the reverse 
direction to the original.

Repeat Duplicate an outline in the same direction – 
typically used with closed shapes.

Column A Digitize column of of turning stitches of 
varying width.

Column B Digitize column of turning stitches, where 
opposite sides are different.

Column C Digitize column or border of fixed width.

Complex Fill Digitize filled shape with a single stitch angle 
in the current stitch type – outline only.

Complex 
Turning

Digitize filled shape with turning stitches in the 
current stitch type – outline only.

Star Digitize star shape filled with zigzag stitching.

Ring Digitize circle and oval-shaped ring.

Manual See Manual tools for details.

Use Motif Add motifs to design one-by-one. Rotate, 
scale, or mirror as you add. 

Branching Automatically sequence and group like 
embroidery objects. 

Manual
Digitize individual ‘manual’ stitches. Manual 
objects have no outlines, only stitches. Stitch 
density does not change. 

Triple 
Manual

Digitize triple ‘manual’ stitches. Manual 
objects have no outlines, only stitches. Stitch 
density does not change. 

Outlines

Run Use for single stitch run outlines and details. 
Apply to open or closed shapes.

Sculpture Run
Use for alternating triple-single stitch run for 
a hand-stitched look. Apply to open or 
closed shapes.

Triple Run Use for heavier triple stitch outlines and 
details. Apply to open or closed shapes.

Backstitch
Use to create traditional backstitch outlines 
for delicate borders. Apply to open or closed 
shapes.

Stemstitch
Use to create traditional stemstitch outlines 
for decorative details such as stems and 
vines. Apply to open or closed shapes.

Motif Run
Use for ornamental craftstitch outlines. 
Choose from a motif library. Apply to open 
or closed shapes.

Satin Use for glossy satin borders or columns of 
even width. Apply to open or closed shapes.

Satin Raised
Use to create layered satin borders or 
columns of even width for a raised surface. 
Apply to open or closed shapes.

Zigzag Use to create borders or columns of even 
width for an open 'sawtooth' effect.
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Stitch Effects toolbar
The Stitch Effects toolbar contains tools for modifying 
or improving stitch quality, including applying 
automatic underlay to selected objects. Right-click for 
settings.

View toolbar
The View toolbar commands for viewing embroidery 
designs – e.g. as design outlines, by stitches, by 
machine functions, as they will stitch out on the fabric 

E Stitch Use to create borders or columns of even 
width for an open 'comb' effect.

Tatami
Use to create borders or columns of even 
width for different needle penetration 
patterns.

Program Split
Use to create borders or columns of even 
width for decorative needle penetration 
patterns.

Square Use to create borders or columns of even 
width for an open 'toothed' effect.

Contour Use for contoured stitching following 
borders or columns of even width. 

Coil Use to create borders or columns of even 
width for an open ‘coil’ effect. 

Vector Outline Use to create vector outlines. Apply to open 
or closed shapes.

Fills

Satin Use to create glossy satin fills for narrow 
shapes. Apply to closed shapes.

Satin Raised Use to create layered satin fills for a raised 
surface. Apply to closed shapes.

Zigzag Use to create zigzag fills for an open 
'sawtooth' effect. Apply to closed shapes.

E Stitch Use to create  E stitches for an open 'comb' 
effect. Apply to closed shapes.

Tatami
Use to create solid stitching for large 
shapes with different needle penetration 
patterns. Apply to closed shapes.

Coil Use to create open coil fills. Apply to closed 
shapes.

Square Use to create open straight parallel fills. 
Apply to closed shapes. 

Double 
Square Use to create grid fills. Apply closed shapes. 

Island Coil Use to create concentric rows of coil fills. 
Apply closed shapes. 

Program Split
Use to create solid decorative fills using 
needle penetrations to form tiled patterns. 
Apply to closed shapes.

Motif Fill

Use to create decorative fills using 
embroidery motifs to form repeating 
patterns. Choose from a motif library. Apply 
to closed shapes.

Cross Stitch Use to fill large areas with low stitch count 
cross-stitch fills. Apply to closed shapes.

Contour
Use to create curved fills where stitches 
follow contours of a shape. Apply to closed 
shapes.

Spiral
Use to create spiral stitching radiating from 
the center of the object. Apply to closed 
shapes.

Stipple Fill
Use to create a stipple fill which meanders 
randomly within a shape. Apply to closed 
shapes.

Stipple 
Backstitch

Use to create a stipple backstitch fill which 
meanders randomly within a shape. Apply 
to closed shapes.

Stipple 
Stemstitch

Use to create a stipple stemstitch fill which 
meanders randomly within a shape. Apply 
to closed shapes.

Vector Fill Use to create a vector fill. Apply to closed 
shapes.

Auto Underlay Generate automatic underlay for selected 
objects. Right-click for settings.

Pull 
Compensation

Apply to selected objects to compensate for 
fabric stretch. Right-click for settings.

Auto Jump Preserve long stitches in new and selected 
objects. Right-click for settings.

Shortening
Reduce stitch bunching in tight curves by 
shortening stitches along inside edge. 
Right-click for settings.

Fractional 
Spacing 

Even out stitch density along inside and 
outside edges. Right-click for settings.

Mitre Corners Create sharp mitre corners at intersections. 
Right-click for settings.

Cap Corners Create capped corners for fewer stitches. 
Right-click for settings.

Lap Corners Create ‘Tidori’ style corner stitching. 
Right-click for settings.

Jagged Edge
Create rough edges, shading effects, or 
imitate fur and other fluffy textures in 
selected objects. Right-click for settings.

Trapunto Force underlying travel runs to the edges of 
selected objects. Use with open stitching. 

User-Defined 
Split

Create custom split-line effects. Right-click 
for settings.

Accordion 
Spacing

Create perspective and shading effects 
with stitch spacing varying between dense 
and open fill. Right-click for settings.

Flexi Split
Create decorative split patterns following 
stitch angles and scaled according to object 
width. Right-click for settings.

Radial Fill Apply or exclude Radial Fill effect to new or 
selected objects. Right-click for settings.

Florentine 
Effect

Create custom curve-line stitching with a 
single guideline. Right-click for settings.

Liquid Effect Create custom curve-line stitching with twin 
guidelines. Right-click for settings.

3D Warp Create 3D effects in selected motif fills. 
Right-click for settings.
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– either separately or in combination. Right-click to 
access settings. See also Viewing Designs.

Zoom toolbar
Zoom tools allow you to magnify your view of the 
design by zooming in on individual stitches or details, 

or zoom out to view more of the design. See Zooming 
& panning designs for details.

Sequence toolbar
The Sequence toolbar provides a convenient means 
for sequencing selected objects. Use it in conjunction 
with the Color-Object List. See Sequencing 
embroidery objects for details.

Transform toolbar
The Transform toolbar contains tools for mirroring, 
rotating and skewing objects. See Modifying Objects 
for details.

TrueView Toggle between stitch view and TrueView.

Show 
Stitches Toggle embroidery stitching display.

Show 
Outlines Toggle object outlines display.

Show 
Needle 
Points

Toggle needle point display.

Show 
Connectors Toggle connecting stitch display.

Show 
Functions Toggle display of machine function symbols.

Show 
Repeats Toggle design repeats display.

Show 
Bitmaps Toggle bitmap images on or off.

Show 
Vectors Toggle vector graphic display.

Show 
Graphics as 
Dimmed

Dim graphic backdrops to show stitches more 
clearly for digitizing.

Show 
Appliqué 
Fabric

Toggle appliqué fabric display.

Show 
Product

Toggle current product display. Right-click for 
Product Visualizer settings.

Show Hoop Toggle hoop display.

Show Bling Toggle rhinestone (bling) display.

Show Grid Toggle grid display.

Show Rulers 
& Guides Toggle rulers & guides display.

Design Measurement system: Change 
measurement units within software without 
changing system settings. 

Auto Hoop
Prompt system to select a hoop from My 
Hoops list. Right-click Show Hoops for 
settings.

Auto Start & 
End Set auto start and end points for entire design.

Stitch Player Simulate embroidery design stitchout on 
screen.

Zoom Zoom in or out via left and right mouse clicks, or 
drag a selection marquee to view design detail.

Zoom 1:1 Display design at actual size.

Zoom Factor: Select zoom scale from the 
droplist or key in a zoom factor and press Enter.

Zoom to 
Fit Display whole design in design window.

Zoom to 
Selected Magnify only selected objects.

Zoom to 
Product View entire product in the design window.

Zoom to 
Hoop Display entire hoop in the design window. 

Back 1 
Object

Move a selection back one object in the 
stitching sequence. 

Forward 1 
Object

Move a selection forward one object in the 
stitching sequence. 

Back 1 Color Move a selection back one color in the 
stitching sequence. 

Forward 1 
Color

Move a selection forward one color in the 
stitching sequence. 

Move to Start Move a selection to start of stitching 
sequence. 

Move to End Move a selection to end of stitching sequence. 

Sequence by 
Selects Resequence objects in the order selected.

Sequence by 
Color

Resequence all blocks of like color. (To 
maintain separate color blocks, use the 
Color-Object List.)

Mirror X Flip selected objects horizontally.

Mirror Y Flip selected objects vertically.

Mirror by 
Reference 
Line

Mirror objects around a defined axis using a 
reference line.

Rotate Left 
45°

Rotate selected objects by 45° in 
counter-clockwise direction.
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Styles toolbar
Use the Styles toolbar to apply pre-defined styles to a 
design. The tools let you:

 Apply current settings to selected objects
 Change current settings, and
 Apply styles to selected objects.

The styles you select as ‘favorites’ are each assigned a 
tool icon on the toolbar. See Working with styles for 
details.

Stitch toolbar
The Stitch toolbar contains a group of tools 
concerning with stitch level editing and processing. 
See also Stitches & Machine Functions.

Function toolbar
Function tools allow you to insert machine functions 
manually. See Stitches & Machine Functions for details.

Caution  When you insert stitches or machine 
functions manually, you must maintain them manually. 
If an object’s stitches are regenerated for any reason, 
all stitch editing and machine functions are lost.

Legacy Features toolbar
Newer machines use USB or Wired-Wireless network 
connections. They can appear as a disk drive or be 
setup to read designs from a folder on the PC. Older 
machines use serial ports or even proprietary 
embroidery disks. The Legacy Features toolbar 
contains functions for connecting to older styles 
machines. See Outputting Designs for Production for 
details.

Rotate Right 
45°

Rotate selected objects by 45° in clockwise 
direction.

Rotate: Rotate selected objects by specified 
amount - positive or negative - in degrees.

Skew: Skew selected objects by specified 
amount - positive or negative - in degrees.

Transform by 
Reference 
Line 
Numerically

Transform selected objects using a 
combination of reference points and 
numeric values.

Transform by 
Reference 
Line Freely

Rotate selected objects with the aid of 
reference points alone.

Make 
Properties 
Current

Make properties of a selected object current 
for the design.

Apply 
Current 
Properties

Apply current settings to selected objects.

Favorite 
Style

Assign up to 10 favorite styles via Manage 
Styles. Select object and click button to apply.

Apply Style Apply pre-defined style to selected objects.

Generate 
Stitches Generate stitches for selected objects.

Stitch Edit Select individual stitches for editing.

Selects 
On/Off

Select a range of objects as you travel 
through the design.

Process 
Stitches

Adjust stitch density of and/or scale whole or 
selected parts.

Split Object
Split object in two at current needle position. 
Use with Travel by Stitch functions.

Penetrations
Toggle Penetrations function. Use to engage 
needles or borers, or disengage to create 
jumps. 

Borers Toggle Borers function. Use for cutting holes 
in fabric.

Insert Stop Insert Stop function at current stitch cursor 
position. 

Insert Tie-off Insert Tie-off function at current stitch cursor 
position. 

Insert Trim Insert Trim function at current stitch cursor 
position.

Insert Empty 
Stitch 

Insert Empty stitch function at current stitch 
cursor position.

Insert Empty 
Jump

Insert Empty jump function at current stitch 
cursor position.

Insert 
Function

Insert machine function at current stitch 
cursor position.

Clear 
Function

Remove machine functions from current 
stitch cursor position. 

Edit Function Edit machine function at current stitch cursor 
position.

Slow Insert Slow function to decrease machine 
speed.

Fast Insert Fast function to increase machine 
speed.

Send to 
Machine 
Manager

Send multiple designs to machine from 
EmbroideryStudio or DesignWorkflow and 
view or manage job queues. 

Send to 
Stitch 
Manager

Send current design direct to embroidery 
machine for production.

Embroidery 
Disk

Open designs from or save to proprietary 
embroidery disk formats.

Hardware 
Setup

Set up a machine connection with name, port, 
and protocol.



   Quick Reference 890

Travel toolbar
The Travel toolbar contains tools for viewing the 
stitching sequence of a design color-by-color, 
object-by-object, or stitch-by-stitch. Traveling can be 
initiated from any stitch in a design. See Viewing 
stitching sequence for details.

Sequin toolbar
The Sequin toolbar provides a dedicated set of sequin 
tools which allow you to digitize sequined designs for 
compatible machines. There are also tools for creating 
boring holes. See Sequin Digitizing for details. 

Bling toolbar
The Bling toolbar contains tools for creating bling runs 
as well as fills. There are two available types of bling 
run: Simple Run (same size stones) and Pattern 
Run (different sizes following a regular pattern).

Chenille toolbar
If you have a Chenille option installed with your 
EmbroideryStudio system, the design window will 
include a Chenille toolbar containing specific Chenille 
stitch types and machine functions. See Chenille User 
Manual Supplement for details.

Start/End 
Design

Move stitch cursor to the start/end of design. 
Left/right-click.

Travel by 
Object

Move stitch cursor to the next/previous object. 
Left/right-click.

Travel by 
Segment

Move stitch cursor to the next/previous 
segment. Left/right click.

Travel by 
Color

Move stitch cursor to the next/previous color 
change. Left/right click.

Travel by 
Function

Move stitch cursor to the next/previous 
machine function. Left/right click.

Travel by 
Trim

Move stitch cursor to the next/previous Trim 
function. Left/right click.

Travel 1000 
Stitches

Move stitch cursor forwards/backwards 1000 
stitches at a time. Left/right click.

Travel 100 
Stitches

Move stitch cursor forwards/backwards 100 
stitches at a time. Left/right click.

Travel 10 
Stitches

Move stitch cursor forwards/backwards 10 
stitches at a time. Left/right click.

Travel 1 
Stitch

Move stitch cursor forwards/backwards 1 
stitch at a time. Left/right click.

Sequin 
Palette 
Editor

Select sequins for the design from a sequin 
library.

Sequin Palette: Select sequin shapes for the 
current design.

Manual 
Sequin

Digitize individual sequin drops. Right-click for 
settings.

Left Sequin Switch to left sequin when digitizing 
twin-sequin designs.

Right Sequin Switch to right sequin when digitizing 
twin-sequin designs.

Sequin Run 
Auto

Create a string of sequins along a digitized 
line. Right-click for settings.

Sequin Run 
Manual

Digitize sequin-drops along a digitized line. 
Right-click for settings.

Sequin Fill Digitize and fill larger shapes with sequins. 
Right-click for settings.

Sequin Edit Fine-tune placement of individual sequins 
within selected sequin objects. 

Vectors to 
Sequins

Create sequin runs from sequin artwork. 
Digitize a guideline connecting the sequins to 
include within a run.

Drop Sequin
Drop a sequin at the current needle position. 
For twin-sequin machines, left-click to drop a 
left-sequin, right-click to drop a right-sequin.

Clear 
Function

Remove any sequin functions from the 
current needle position.

Bling Palette 
Editor

Select rhinestones for the design from a bling 
library.

Bling Manual Digitize individual bling drops.

Bling Run 
Auto

Create a string of rhinestones along a 
digitized line. Right-click for settings.

Bling Fill Digitize and fill larger shapes with 
rhinestones. Right-click for settings. 

Bling 
Lettering

Create bling lettering onscreen using native 
embroidery fonts or TrueType fonts. 
Right-click for settings.

Automatic 
Overlap 
Removal

Toggle on to remove excess rhinestones in 
overlapping Bling objects.

No 
Automatic 
Overlap 
Removal

Toggle on to preserve rhinestones in 
overlapping Bling objects.

Highlight 
Bling 
Overlaps

Toggle on to highlight overlapping 
rhinestones. Use with manual edits.

Bling Edit Fine-tune placement of individual rhinestones 
within selected Bling objects.

Show Bling 
Work Area

Visualize design within the work area of the 
selected machine model. Right-click for 
settings.

Chain
Create decorative stitching resembling links 
of a chain – used for outlines and borders as 
well as monograms. 

Moss
Create dense cover using looped stitch 
typical of Chenille raised stitching – best 
with simple shapes.

Needle Height Control height of loop formed when sewing 
Moss stitch as well as width of Chain stitch.

Compound 
Chenille

Use with Complex Fill to automatically 
generate Moss or Chain stitch run-arounds 
for complex shapes. Right-click to adjust 
offsets.

View by Chain 
/ Moss

View Chenille objects to allow easy 
identification of Chain and Moss elements – 
lockstitch in green, Chain in blue, Moss in 
red.

Maciej
Highlight

Maciej
Highlight

Maciej
Highlight

Maciej
Highlight
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Schiffli toolbar
If you have a Schiffli option installed with your 
EmbroideryStudio system, the design window will 
include a Schiffli toolbar which contains specific Schiffli 
functions. See Schiffli User Manual Supplement for 
details.

Manage Designs toolbar
Manage Designs tools allows for fast searching of 
designs on shared network drives. This is important for 
businesses with multiple computers and multiple users 
creating and accessing EMB or machine format 
designs. See Managing Designs for details.

View (Design Library) toolbar
Design Library allows for fast searching of designs on 
shared network drives. This is important for 
businesses with multiple computers and multiple users 
creating and accessing EMB or machine format 
designs. The View (Design Library) toolbar contains 
functions for quick search, sort, and location of designs 
on your company network. See Managing Designs for 
details.

Blatt Reduce thread tension.

Stepp Increase thread tension.

End Jump Insert End Jump function to engage needles 
or borers.

Begin Jump Insert Begin Jump function to disengage 
needles or borers.

Slow Insert Slow function to decrease machine 
speed.

Fast Insert Fast function to increase machine 
speed.

Borer In Insert Borer In function to engage borer.

Borer Out Insert Borer Out function to disengage borer.

Borer Depth: Set cutting depth to determine 
borer hole size – valid depths are 1-13 for 
Plauen and 0-12 for Saurer.

RPM- Insert RPM- function to decrease turning 
speed of machine.

RPM+ Insert RPM+ function to increase turning 
speed of machine.

Fadenleiter- Insert Fadenleiter- function to decrease 
Fadenleiter stroke by one increment.

Fadenleiter+ Insert Fadenleiter+ function to increase 
Fadenleiter stroke by one increment.

Thread 
Brake-

Insert Thread Brake- function to decrease 
thread brake pressure.

Thread 
Brake+

Insert Thread Brake+ function to increase 
thread brake pressure.

Drop Sequin Insert Drop Sequin function to trigger a 
sequin drop.

Schiffli 
Arrangement

Split designs into color blocks which are then 
arranged into logical parts.

New from 
Selected

Create new design(s) based on the design(s) 
selected in the My Designs window. 

Open 
Selected

Open the design(s) selected in the My 
Designs window. 

Open Recent 
Designs

Open a design from a list of recently opened 
designs.

Cut Cut selection and place it on the clipboard. 

Copy Copy selection and place it on the clipboard. 

Paste Paste contents of the clipboard.

Convert 
Selected 
Designs

Convert the design selected in the My 
Designs window into different file types. 

Send to 
Connection 
Manager

Stitch the design selected in the Embroidery 
Library. 

Print 
Selected

Print the design selected in the My Designs 
window. 

Print 
Selected to 
Catalog

Print the selected designs set in to a catalog. 

Export 
Design List

Export a text or CSV file containing a list of 
the visible design files and their properties. 

Find 
Embroidery 
Designs

Search the computer for folders containing 
embroidery to add to the library. 

Add Folder to 
Library

Add an existing folder to the Embroidery 
Library. This enables fast searching and 
filtering of the folder. 

Remove 
Folder from 
Library

Remove a folder from the Embroidery 
Library. This only removes the link to the 
folder from within the library. It does not 
actually delete the files in the folder from 
storage. 

Layout Toggle the navigation pane, details pane, 
and/or preview pane display.

Design 
Properties Toggle the Design information docker display. 

Change 
View Change your view of design lists.

Group Designs By: Group the current list of 
designs by the selected property. 

Ascending 
Order Group designs in ascending order. 

Descending 
Order Group designs in descending order. 

Sort Designs By: Sort the current list of 
designs by the selected property.

Maciej
Highlight

Maciej
Highlight
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Show Showing: Filter the current list of designs by 
file type. 

Find Designs: Filter designs based on the 
given search criteria. 




